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1 Introduction

CMacTEX is an implementation of TEX for Mac OS X which includes pdftex, metafont,
metapost, bibtex, makeindex, maketexpk, dvips, macdvi, and several utilities for manip-
ulating TEX fonts, Postscript files and Postscript fonts. CMacTEX can be configured to
work in an integrated fashion with BBEdit, TextWrangler, and Alpha. This version of
CMacTEX requires at least OS 10.2 and universal binaries are available for Intel Macs.

• The CMacTeX program is the control center when typesetting a document. From
it you issue commands to typeset the document, to convert dvi files to Postscript,
to make indices and bibliographies, to convert Postscript to PDF, and to view dvi,
Postscript, or PDF files.

• Pdftex can generate either pdf or dvi output.

• Maketexpk can generate pk files from Metafont sources and from pfb Postscript
fonts. It can be called automatically by macdvi to generate missing pk files.

• Macdvi is the dvi previewer supplied with CMacTEX. It can display certain types
of included eps graphics, has full support for color, and can display the Postscript
fonts by converting them to pk format.

• Dvips has been upgraded to version 5.97 and provides better support for partial
downloading of Postscript fonts. The dvips manual is available in pdf format.

• MacGhostView 4.5 is an independent suite of programs for viewing postscript files
and converting postscript files to other formats. It is used by macdvi to display
included eps graphic files and is used by maketexpk to convert postscript fonts to
pk format. These programs are available as a separate download.

This manual only attempts to explain how CMacTEX works as a TEX installation. It
does not try to explain any of the subtleties of TEX. For this kind of information you
should consult any of the numerous books on TEX.

All of the programs included with CMacTEX share a common interface and this man-
ual will discuss only a few of the programs in detail.
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2 Shareware Registration and Warranty

The shareware registration fee for CMacTEX is US $35 for a single user. A site license
(up to 100 users) is available for US $350. The fee is the same even if you are using only
a part of CMacTEX. A registered user is entitled to free updates and technical support.
When you pay the registration fee, I will send you a password via e-mail that will dismiss
those nagging dialog windows. This password also works with MacGhostView. You can
pay the registration fee by credit card through PayPal (http://www.paypal.com, my PayPal
ID is tom@kiffe.com) or Kagi Shareware (https://order.kagi.com/?TK ). I prefer registrations
through PayPal since their processing fees are much lower than those of Kagi. If you are
paying the registration fee by a check drawn on a US Bank or an international money
order, you can send the payment directly to me and thus avoid the additional delay in
receiving your password. If you send a check, make sure that it is payable to me.

Thomas R. Kiffe
P.O. Box 9910
College Station, Texas 77842
USA

Be sure to include your e-mail address with your remittance.
Tom Kiffe hereby disclaims all warranties relating to this software, either expressed

or implied, including without limitation any implied warranties of fitness for a particular
purpose. Tom Kiffe will not be liable for any special, incidental, consequential, indirect or
similar damages due to loss of data or any other reason, even if Tom Kiffe or an agent of his
has been advised of the possibility of such damages. In no event shall Tom Kiffe’s liability
for any damages ever exceed the price paid for the license to use the software, regardless of
the form of the claim. The person using the software bears all risk as to the quality and
performance of the software.

Any comments, suggestions, questions, and bug reports may be sent to me via e-mail.
My address is tom@kiffe.com.
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3 Installing CMacTEX

3.1 Installation

The installation of CMacTEX is really quite simple. CMacTEX comes with default search
paths and, if you follow the steps below, you should not have to set any paths yourself in
order to get CMacTEX up and running. Later you can set your own search paths after you
have decided how to organize all of the files included in CMacTEX.

1. Unpack cmactex45.dmg.zip and move the CMacTeX 4.5 folder to any location you
wish.

2. If you are using BBEdit or TextWrangler open the BBEdit support folder and move
the scripts to your Library/Application Support/BBEdit/Scripts folder.

3. Unpack macghostview.dmg.zip and move the MacGhostView folder to any location
you wish.

CMacTEX 4.5 comes with two sets of programs. The binaries folder contains versions
of the programs which run under any version of OS X. The binaries-intel folder contains
universal binaries which require at least OS 10.4.11. Unless you have an Intel Mac I
suggest that you use the programs in the binaries folder. The folder you don’t use should
be removed from the CMacTEX 4.5 folder.

3.2 Configuration

Launch the setpaths program to create the CMacTeX Preferences file.
Choose the Initialize default search paths item under the File menu. You will have

to do this whenever you add any files or folder to the texmf-cmt, texmf-local or texmf
folders. Now choose Use databases for file searches under the File menu.
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4 SetPaths and File Searching

A typical TEX installation consists of thousands of support files distributed over hundreds
of folders. The programs in a TEX distribution must be able to find these files efficiently.
CMacTEX organizes its support files in accordance with the TEX Directory Structure im-
plemented in most TEX installations. The support files common to any TEX installation
are contained in a texmf folder. Inside this folder the files are organized by type. Generic
files supplied by the user are organized in a similar fashion inside a folder called texmf-local
or texmf-user. Files specific to CMacTEX are organized inside a folder called texmf-cmt.

The folders, if they exist, must have these names and they must be located in the same
folder as the binaries folder. If you wish to keep a texmf tree outside of the binaries folder,
make an alias to the folder and put the alias inside the binaries folder. The name of the
alias must be one of texmf-cmt, texmf-user, texmf-local, or texmf. CMacTEX first searches
the texmf-cmt folder, then the texmf-user folder, then the texmf-local folder, and finally
the texmf folder.

The sole function of the setpaths utility is to set the search paths used by CMacTEX.
The default search paths built into CMacTEX will work only if you have followed the
installation instructions exactly so that all of the programs are in the binaries folder and all
support files are in folders or aliases named texmf, texmf-local, texmf-user, and texmf-cmt.
Setpaths resolves all aliases when it initializes search paths so you can use aliases to refer to
particular folders located outside the texmf folders.

You must initialize search paths whenever you add new files or folders to any of the
texmf folders. The expanded search paths are stored in the CMacTEX preferences file,
CMacTeX Preferences, which is in your Preferences folder. If this file is not present or it
is corrupted, CMacTEX will not be able to find any support files. I recommend that you
periodically make a copy of CMacTeX Preferences and store it in a safe place. If CMacTeX
Preferences becomes corrupted you will have a current replacement file and will not have
to configure CMacTEX from scratch.

The characters /, %, and ‘nonbreaking space’ (option-space on a Macintosh, ascii code
202) are special and may not be used in file and folder names. CMacTEX uses Unix
style path names internally and / is the Unix directory separator. If you are transferring,
from a Unix platform, a complex document that contains Unix paths, CMacTEX will
translate those paths automatically into Macintosh paths. Some TEX programs do not
work correctly if a file or folder name contains a space character. Since a space character
in a file or folder name is quite common on a Macintosh, CMacTEX internally converts
a space character to a nonbreaking space and vice versa. The % symbol is used to specify
special search paths for pk files. Make sure that no files or folders in your TEX tree have
names containing a /, %, or ‘nonbreaking space’ before you run setpaths.

4.1 Search Variables

Here is a brief summary of the search variables used by CMacTEX. More detailed infor-
mation on how a particular program uses a search path is included with that program.

TEXINPUTS pdftex searches these folders for tex macro files and cfg files.
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TEXFORMATS pdftex searches these folders for format (.fmt) files, pool files,
and cnf files.

TEXPOOL pdftex searches these folders for pool files.

TEXFONTS pdftex, dvips, macdvi, and metapost search these folders for tex
font metric (.tfm) files.

PKFONTS dvips, macdvi, and pdftex search these folders for pk font files.

VFFONTS dvips, macdvi, and pdftex search these folders for virtual font
files.

MFINPUTS metafont and metapost look here for macro (.mf) files

MFBASES metafont searches for base (.base) files and cnf files in these fold-
ers.

MFPOOL metafont searches for pool files in these folders.

TEXCONFIG dvips looks here for config and mapping files.

DVIPSHEADERS these folders contain the header files and encoding files used by
dvips and pdftex.

TYPE1FONTS dvips and pdftex search these folders for Postscript fonts.

DVIPSEPSF dvips searches these folders for epsf files.

BIBINPUTS bibtex searches for .bib files in these folders. Bibtex also looks
here for csf files.

BSTINPUTS bibtex searches for .bst files in these folders.

ISTINPUTS makeindex searches for .ist files in these folders.

MPINPUTS metapost looks in these folders for macro (.mp) files.

MPMEMS metapost searches these folders for mem (.mem) and cnf files.

MPPOOL metapost looks here for pool files.

MTPKTMPFOLDER maketexpk puts the pk files it generates in this folder.

The default folders that are used by these variables are listed in the file default.paths. If
you are not using a TDS tree structure you can use this file as a template for creating your
own search paths.

4.2 Initializing Search Paths

Under the File menu setpaths has two commands for initializing search paths. To set the
default search paths select Initialize default search paths. If you have created your own
default.paths file you can use it to set search paths by selecting Initialize search paths
from file. Setpaths will expand all search paths, resolve any alias folders, and write the
database files.

4.3 Database File Searches

CMacTEX can be configured to search databases for macro and font files rather than search-
ing your hard drive. Database searching is considerably faster than disk searching, espe-
cially if a large number of files have to be found. The databases are used by pdftex, macdvi,
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and dvips. The databases are created whenever you initialize search paths and they are
placed in the CMacTeX folder inside your Library:Application Support folder. Database
searching can be turned on and off with the Use databases for file searches item under
the File menu.

4.4 Search Paths for pk Files

Dvips, macdvi, and pdftex can generate missing pk files from appropriate metafont sources
by calling maketexpk. The default configuration for CMacTEX organizes pk files by meta-
font mode and dpi. It may be necessary for maketexpk to create new folders when gener-
ating pk files and these folders must be searched when programs are looking for pk files.
Since setpaths can handle only existing folders when it initializes search paths, a method
had to be created for handling new pk files and folders . This is done by creating the
variable search path texmf-cmt/pk/%m/%d/%f.%dpk. Dvips, macdvi, and pdftex use
this variable search path when looking for pk files and maketexpk uses it when creating
pk files. The general rule is that if a % character is found in a path, the following substi-
tutions will be made, and then a search will be made for the resulting file. %f is replaced
by the font name, %d is replaced by the font size in dots per inch, and %m is replaced by
the Metafont mode. Note that the variable search path must expand to the full file name,
including the path from the pk folder, rather than just the name of a folder. If you just
used texmf-cmt/pk/%d instead of texmf-cmt/pk/%m/%d/%f.%dpk, dvips, macdvi,
and pdftex will try to open .../texmf-cmt/pk/329 when looking for cmr10.329pk, for in-
stance, and this is not what is intended. This variable search path must expand to a file
name after the substitutions are made.
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5 CMacTEX

CMacTeX is the command center when typesetting a document and is probably the only
program you will launch from the Finder. From CMacTeX you can issue commands to
typeset your document with either the plain or latex format, launch the dvi previewer,
convert the dvi file to Postscript, launch the Postscript viewer, convert Postscript to PDF,
launch the PDF viewer, make indices and bibliographies, and build format files.

5.1 Menu Commands

5.1.1 File Menu

Typeset Choose a file to be typeset.

Typeset xxx Typeset the last file processed, provided that file still exists
in its original location.

Typeset recent Select a file for typesetting from a list of recently opened
files.

Repeat last TeX command Redo the last command executed by any TeX program.

Build format This command can be used to build format files. You can
modify the command line and use the “Set Directory”
button to make sure that format files are placed in the
correct folder.

bibtex xxx.aux Run bibtex on the aux file created by tex.

View xxx.dvi View the indicated dvi file.

dvips xxx.dvi Convert the dvi file to Postscript by calling dvips.

View xxx.ps Call a previewer to display the indicated Postscript file.

Ps2pdf xxx.ps Convert the indicated Postscript file to PDF by calling
macps2pdf, Distiller, or any other converter which re-
sponds to an “Open doc” event.

View xxx.pdf Call a PDF viewer to display the indicated PDF file.

Save Save the output written to the console in a file.

5.1.2 Edit Menu

Clear Clear the console window.

Console font Set the font to be used to display text in the console win-
dow.

Font size Set the size of the font to be used to display text in the
console window.

8-bit output Use 8-bit characters in the console window and in .log
files.

Info View information about the selected program.

Open config file Ask your text editor to open the selected configuration
file.
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5.1.3 Options Menu

TeX format Choose the format to be used by pdftex.

DVI output By default pdftex produces PDF output. When this item
is checked it will produce traditional dvi otput.

Enable synctex When this item is checked pdftex creates special code
linking either the dvi file or pdf file created with the orig-
inal source file. Macdvi uses this code to link the created
dvi file to the tex source files. Some PDF previwers, like
Skim, can use the code to link the created PDF file to the
tex source files.

Turn on recorder When this item is checked pdftex creates a file foo.fls
which lists all the files opened by pdftex when typesetting
foo.tex. It is useful when debugging your tex sources.

pdftex options Set some options when using pk font files with PDF out-
put.

Auto switch to previewer This item tells CMacTeX to launch the dvi or pdf pre-
viewer automatically after it is finished processing a file.
The switch occurs only if the tex program returns a zero
exit code to CMacTeX.

Debug paths If this item is checked, tex and pdftex will print the full
names of all the files they are trying to open. This feature
is useful if tex reports that it cannot find a file or you are
trying to debug your installation.

Set search paths This item launches setpaths, from which the user can set
or change the search paths used by tex.

Set apps This item allows you to set some of the programs that
can be launched from CMacTeX.

bibtex options Set options for running bibtex.

dvips options Set options for running dvips.

mpost tex format Set the format for pdftex to use when called by mpost.

The Apps Menu can be used to run selected programs from CMacTeX. When any item
under this Menu is selected, a dialog window appears in which you specify input and
output files for the selected program. The Transfer Menu simply allows the user to launch
some other program.
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6 Pdftex

CMacTeX includes pdftex for converting tex source files. It can produce either a traditional
dvi file or a PDF file. The program has no useful interface. It is designed to be called by
CMacTeX for typesetting a document and there is no reason to launch it directly.

When launched pdftex read a configuration file pdftex.cnf. This file has settings for
various memory parameters used by pdftex and it is searched for in the folders specified by
the TEXFORMATS variable. If this file is not found, the program will use built-in values
for its memory parameters. If the program prints any error messages about its memory
capacity being exceeded, you may want to increase some of the values specified in this file.
Changing these parameters may require you to rebuild your format files.

CMacTeX includes two prebuilt formats, pdftex and pdflatex. You to easily build your
own custom formats.

• The pdftex format is the plain format built with the extended features of eTEX.

• The pdflatex format is the latex format built with the extended features of eTEX.

Pdftex requires that a number of paths be set correctly in order for it to work at all.
The paths used include TEXFONTS, TEXINPUTS, and TEXFORMATS. TEXFONTS
is the list of folders in which pdftex looks for tfm files, TEXINPUTS is the list of folders
for macro (.tex) and style files, and TEXFORMATS is the list of folders for format(.fmt)
files.

6.1 Configuring pdftex

There are two default settings for pdftex that you may wish to change, paper size and
hyphenation patterns.

• The default paper size used by pdftex is letter. To change to a4 or any other paper
size you must edit pdftexconfig.tex.

• By default pdftex only includes hyphenation patterns for US English. To add hy-
phenation patterns for other languages you must edit language.dat for plain tex
and language.def for latex.

All three of these files are located in the folder texmf/tex/generic/config. Changing either
paper size or hyphenation patterns requires you to rebuild all pdftex format files.

6.2 Including graphics

When pdftex is in PDF mode it includes any graphic files in its final output. Most graphics
programs produce encapsulated postscript files (eps) files. These files must be converted to
PDF format before running pdftex. CMacTeX includes epstopdf, a utility for converting
eps files to pdf format.
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6.3 Embedding postscript fonts

When producing PDF output pdftex must embed the fonts used by the document into
the PDF output. (Dvi files do not contain actual fonts; they only contain font metrics.)
Pdftex looks in the folders specified by the DVIPSHEADERS and TYPE1FONTS paths
for Postscript mapping, encoding, and font files. All tex-font-to-postscript-font mappings
are listed in the file pdftex.map located in the texmf-cmt/fonts/map folder. If you add
any fonts to CMacTeX you may have to add entries for those fonts to pdftex.map.
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7 Metafont

Metafont reads the program in the specified files and outputs font rasters (in gf format)
and font metrics (in tfm format). The Metafont language is described in The Metafont
Book.

Like TEX, Metafont is normally used with a large body of precompiled macros, and
font generation in particular requires the support of numerous macro files. To run Meta-
font, launch mf, choose Execute from the File Menu. Set the directory to any folder you
wish and, in the command line dialog box, type

mf \mode=<printengine>; [mag=magstep(n);] input font
to start processing font.mf.

Unless you are a font designer the only reason you will launch mf directly is to build
a base file. To build a base file, launch mf and select Build base from the File Menu. Set
the directory to your mfbases folder and, in the command line dialog box, type

mf -ini -jobname=mf plain \input modes \dump
Mf will create a file called mf.base in the mfbases folder.

When it is launched, mf can read the configuration file mf.cnf, which has alternate
settings for various memory parameters. It will search for mf.cnf in the folders specified
by the MFBASES variable. If this file is not found, mf will use built-in values for these
parameters. If mf prints any error messages about its memory capacity being exceeded,
you may want to increase some of the values set in mf.cnf. Changing these parameters
may require you to rebuild your base files.

7.1 Menu Commands

7.1.1 File Menu

Execute Launch mf.

Build base Build the “plain” base file for Metafont.

Save Save the output written to the console in a file.

7.1.2 Edit Menu

Clear Clear the console window.

7.1.3 Options Menu

Debug paths If this item is checked, Metafont will print the full names
of all the files it is trying to open. This feature is useful
if Metafont reports that it cannot find a file or you are
trying to debug your installation.

Set view window This item allows the user to set the location and size of
Metafont’s viewing window. This window only appears
if you are designing fonts instead of merely generating gf
and tfm files for an existing font.
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Metafont requires that a number of paths be set correctly in order for it to work at all.
The paths used by Metafont include MFINPUTS, MFBASES, and MFPOOL. MFIN-
PUTS is the list of folders in which Metafont will look for macro (.mf) files. MFBASES
is the list of folders in which Metafont will look for base(.base) files. MFPOOL is the list
of folders in which Metafont will look for pool files. These paths are set with the setpaths
utility.

Metafont is also included as an OS X tool in the binaries/bin folder. It is this version
of mf that is called by maketexpk when it is generating pk files. You can’t launch the mf
tool yourself.
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8 Dvips

Dvips is the program that converts dvi files to Postscript files. It supports hyperpostscript
and the partial downloading of Postscript fonts in either pfa or pfb format. Dvips is
designed to be called by the CMacTeX program, just like pdftex.

8.1 Configuring dvips

Be sure to read config.ps carefully and modify it appropriately so that dvips uses the correct
paper size for your installation. Like pdftex, dvips must include the actual fonts in its
output. It reads the file psfonts.map in the texmf-cmt/fonts/map folder to translate tex
fonts into postscript fonts. If a particular font is not found in psfonts.map then dvips will
call maketexpk to generate a pk file for that font.

8.2 Automatic Font Generation

In order to generate the correct pk files dvips needs to know the resolution of your printer
and the metafont mode for your printer. These values are entered in config.ps, the main
configuration file for dvips. The default resolution is 600 and the default metafont mode
is ljfour. Config.ps should contain the settings for your default printer. If you regularly use
more than one printer, you should create printer-specific configuration files rather than
change the values in config.ps. As an example, suppose that you occasionally print on
a NeXT printer. Duplicate config.ps and rename it config.next. Open config.next and
change the resolution to 400 and the metafont mode to nexthi. When you run dvips, use
the Options Menu to load in the config.next file.

The available metafont modes are listed in modes.mf, which should be located in
your mfinputs folder. If you ever have to build the metafont base file, be sure to include
modes.mf.
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9 Macdvi

Macdvi is the program for previewing dvi files. It automatically resolves virtual fonts and
provides full support for color. Even if a dvi file contains no color commands you can still
set foreground and background colors for easier viewing. Since macdvi draws an entire
page in an offscreen bitmap before showing the page on a computer screen, colored text
on a colored background is drawn correctly. Macdvi automatically redisplays an open dvi
file if that file has been modified by another program. The redisplay occurs when macdvi
is brought to the front.

9.1 Displaying fonts

Macdvi can only display fonts that are in pk format and it automatically generates any pk
files it needs either from metafont sources or from postscript pfb files. When it encounters
a font it first searches for an existing pk file for that font and size. If one is not found it
calls maketexpk to generate a pk file of the appropriate size. Maketexpk first tries to build
the pk file from metafont sources using mf and gftopk. If no metafont sources for the
font are found maketexpk tries to generate the pk file from a postscript pfb file by calling
gsftopk. To find the appropriate postscript font for the given tex font maketexpk reads
psfonts.map, the same mapping file used by dvips. MacGhostView must be installed in
order to convert postscript fonts to pk files.

9.2 Displaying graphics

It can’t display any Postscript code included in a dvi file with a \special{} or with a package
like pstricks. Macdvi is a dvi previewer, not a Postscript previewer. It can display included
encapsulated Postscript files by converting them to PDF format and displaying the PDF
graphics. MacGhostView must be installed in order to convert eps files to pdf files.

9.3 Src specials

If pdftex is run with the “Enable synctex” option, then the dvi file contains information
linking it to the tex source files. If you option-click in a paragraph in a displayed page
macdvi will print the line number and the name of the source file corresponding to the
mouse click. If you are using either TextWrangler or BBEdit macdvi will ask your editor
to open the source file and highlight the line. There is a TextWrangler-BBEdit script for
jumping from a location in the tex source file to the corresponding position in the dvi file.

9.4 Menu Commands

9.4.1 File Menu

Open Select a dvi file to preview.

Open xxx.dvi Preview the current dvi file, xxx.dvi. This is the last dvi
file created by any application. The item will be disabled
if the current dvi file has been moved or deleted.
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Open Recent Select a file for previewing from a list of recently opened
files.

Close dvi file Close the currently open dvi file.

Page Setup Set options for printing a dvi document.

Print This command prints the selected pages. It sends each
page to your printer as a bitmap image.

Convert to Postscript Call dvips to convert the current dvi file to Postscript.

Save Save the currently displayed dvi page as a PICT file or
save the console output in a file.

9.4.2 Edit Menu

Copy Place the currently displayed dvi page as a PICT resource
on the Clipboard.

Clear Clear the console window.

9.4.3 View Menu

First Page View the first physical page of the document.

Previous page View the previous page, if there is one.

Next page View the next page, if there is one.

Last Page View the last physical page.

Go to page Select a page for previewing.

Go to last viewed page This item tells macdvi to display the page having the
same physical page number as the last page viewed in the
last dvi file. It helps you return to a specific page after
you have made changes to a tex file.

Redraw current page If the display of the current page is not correct, selecting
this item will redraw the page.

Zoom in Increase the magnification of the current page.

Zoom out Decrease the magnification of the current page.

Zoom back View document at previous magnification.

Fit in view Resize the current page so that it fits completely inside
the previewing window.

Maximum size Show the current page at maximum magnification.

View page as Postscript Convert the displayed page into Postscript and open the
Postscript previewer.

Console Window Bring the console window to the front.

Display Window Bring the display window to the front.
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9.4.4 Page Menu

This menu is just a list of the pages in the current dvi file. Selecting one of them displays
that page. Only the first 100 pages are listed under this Menu.

9.4.5 Options Menu

Display Page Geometry Set page size, orientation, and resolution for previewing.
The default resolution for previewing with macdvi is 300
dpi. The value you set here determines the size of the pk
fonts macdvi will use to display the document. If you are
printing on a 300 dpi Postscript printer, macdvi will use
the same pk files for previewing as dvips would use for
printing. You may use whatever resolution you wish for
previewing and macdvi can be set to automatically gener-
ate any pk files it needs if you have installed CMacTEX’s
metafont package. The user can set the color depth used
by macdvi when it displays a page. Macdvi can display
color commands in the dvi file. These commands must
follow the syntax for color commands used by dvips. The
files colordvi.tex and colordvi.sty, supplied with dvips,
explain how to include color commands in your TEX
file so that they cab be used by dvips and macdvi. Any
changes take effect the next time a dvi file is opened. If
automatic pk font generation is turned on, macdvi must
tell metafont which mode to use. This mode must be
consistent with the dpi setting or metafont and gftopk
will not create the correct pk file. If your resolution is
set at 300 dpi, you should set the metafont mode to
CanonCX or cx. See the file modes.mf, supplied with
metafont, for a description of all standard modes and
their corresponding resolutions.

Color preferences With this item the user can set the foreground and back-
ground colors macdvi will use to display a page. Color
commands included in the dvi file will overwrite these
settings.

Screen font If macdvi can’t find a pk font of the correct size and you
are not generating pk fonts, it will try to display the font
characters using a Macintosh screen font. The default
screen font is Geneva and the resulting display is truly
awful.

Make pk fonts If you have installed the metafont package, macdvi can
automatically generate any pk files it needs for preview-
ing. If you don’t want to wait for macdvi to generate
fonts, turn this option off and macdvi will record the
missing fonts in a file called missviewfont.log. You can
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generate the fonts later with maketexpk.

Convert eps graphics When this option is turned on, macdvi will convert an
eps file to a PDF file for previewing graphics, provided
the eps file does not already have a PICT 256 resource.
It calls macps2pdf to do the actual conversion.

Debug paths When this option is turned on, macdvi will print the
name of every file it is trying to open. This is useful
when you are debugging your search paths.

Debug \special When this option is turned on, macdvi will print all
\special commands to the console window and any eps
graphics are enclosed in a box.

Dithering If dithering is turned on, macdvi will render the dis-
played page in gray scale rather than black and white.
This improves the display quality when the file is viewed
at different magnifications.

Key mappings This item allows you to change the keys used to move
around a displayed page of your dvi file.

Slow scrolling Use this option only if you insist on covering part of
macdvi’s display window with one or more floating win-
dows.

9.5 Key Mappings

Pressing various keys while the display window is in front moves you around the page and
the document as follows.

n Go to the next page.

p Go to the previous page.

f Go to the first page.

l Go to the last page.

g Call the Goto Page Dialog Box.

h Center the page horizontally.

v Center the page vertically.

i Zoom in (increase magnification).

o Zoom out (decrease magnification.

u Scroll upward one screen. If at the top of a page, scroll to the bottom of
the previous page.

d Scroll downward one screen. If at the bottom of a page, scroll to the top
of the next page.

The four arrow keys also move you around a page in small increments. The “page up” and
“page down” keys work just like the ‘u’ and ‘d’ keys respectively. The “home” key takes
you to the upper left-hand corner of a page while the “end” key takes you to the lower
right-hand corner.
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10 Other Programs

CMacTEX includes several other programs usually found in any TEX installation.

10.1 Bibtex, MetaPost, and MakeIndex

Bibtex, metapost, and makeindex are described in the standard books concerned with TEX.
Makeindex, mpost, and bibtex should be called from the CMacTeX program..

10.2 Epstopdf

This utility can used to convert a batch of eps files to PDF format. Just select the eps files
in the Finder and drag the icons onto the epstopdf program.

10.3 Postscript Utilities

The type1 font utilities are useful when converting Postscript fonts between pfa, pfb, and
Macintosh format. To convert a number of files you should use one of the Apple Scripts
provided with CMacTEX.

10.4 OS X Tools

These tools are located in the binaries/bin folder. They can’t be launched from the Finder.
Maketexpk calls mf, gftopk, and gsftopk and metapost calls dvitomp. These binaries are
implemented as tools rather than as programs for speed and efficiency.

10.5 MakeTeXPK

Maketexpk is a CMacTeX utility for generating pk files. It is called by macdvi, pdftex,
and dvips when automatic font generation is activated. If automatic font generation is
not activated, these programs generate a file called missfont.log or missviewfont.log which
contains a list of commands for making any missing pk fonts. Later maketexpk can be run
on this file and it generates the missing fonts.

If you have a collection of pk fonts to make, you can create a list of the fonts and their
magnifications in a file and run maketexpk on that file. Each line in the file should consist
of a font name, a design size, a base size, and an optional metafont mode. A typical line
would be

cmr10 360 300 CanonCX

which would produce cmr10.360pk. If no metafont mode is given, the value of localfont,
as defined in modes.mf when the metafont base file was created, will be used. The mode
set by localfont can be overwritten by setting the metafont mode with the Options Menu.
Of course, the Metafont mode must match the base size. To produce a family of pk files
you could have the following lines in your file:

cmr10 300 300 CanonCX
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cmr10 329 300 CanonCX
cmr10 360 300 CanonCX
cmr10 432 300 CanonCX
cmr10 518 300 CanonCX
cmr10 622 300 CanonCX

or just

cmr10 300 300
cmr10 329 300
cmr10 360 300
cmr10 432 300
cmr10 518 300
cmr10 622 300

if CanonCX is your localfont setting or if CanonCX was set with the Options Menu.
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11 Working with Text Editors

CMacTEX can be fully integrated with Alpha, BBEdit, and TextWrangler and it is possible
to run most of the programs from within either of these popular editors. With Menu
selections in your editor, you can have TEX process the file displayed in the front window,
return automatically to the editor and go to the offending line if TEX detects an error,
preview the dvi file corresponding to the front window (if it exists), convert a dvi file to
Postscript and view the Postscript file. These operations are handled quite differently in
Alpha and BBEdit or Textwrangler.

For BBEdit or Textwrangler I have written seventeen Apple Scripts: Convert dvi to
ps, Convert ps to pdf, Goto dvi page, Goto pdf page, latex, latex with src specials, Make
bib, Make index, Open Log File, Open Macro File, pdflatex, pdftex, tex, tex with src
specials, View dvi, View pdf, and View ps. These scripts should be placed in your BBEdit
or TextWrangler Scripts Folder. You will have to edit all of the scripts with Script Editor
to get them to work on your computer.

The scripts perform the indicated action on either the .tex file in the front window,
or the dvi file or Postscript file associated with the front window. If you have returned
to BBEdit from tex by typing an ‘e’ at a ? prompt, BBEdit will highlight the line tex
reported as containing an error. If you are viewing a dvi file containing \src specials
and option-click in a paragraph in a displayed page, macdvi will tell BBEdit to open the
corresponding source file and BBEdit will highlight the first line of the selected paragraph.
The “tex” script calls pdftex with the plain format, the “latex” script calls pdftex with the
pdflatex format, both producing dvi output. The “pdftex” script calls pdftex with the
pdftex format, and the “pdflatex” script calls pdftex with the pdflatex format, producing
PDF output.

Alpha comes with its own set of commands for interacting with TEX.
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